RefWorks

Training Manual

Welcome to RefWorks at Lorain County Community College.

About RefWorks: RefWorks is a citation management software program, paid
for by the LCCC Library and OhioLINK. RefWorks collects, stores, and
organizes citations from books, articles, web sites, and other sources. It
automatically converts citations into properly formatted bibliographies. A
multitude of citation styles are offered. RefWorks interfaces with many of the
LCCC Library's databases, as well as databases at other libraries. RefWorks
also converts citations from other bibliography programs such as Endnote and
Reference Manager.

RefWorks uses a system of folders to store your citations. RefWorks has three
primary functions:

1. Storing citations

2. Creating bibliographies

3. Creating in-text references, footnotes or endnotes

All LCCC students, faculty and staff may set up their own accounts.

Questions about RefWorks should be directed to the LCCC Library Reference
Staff at ext 4106 or to csheetz@lorainccc.edu
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Signing Up for an Account in RefWorks

www.refworks.com and click Login.

RefWOI'k.S 1. Begin at the RefWorks home page by going to
ek : . ,

The Benafi:s
Fincd out v fWorks con do
for yonar = ¢

Testimonials 4 Tric

login,  Products ,

At the RefWorks login center:

R " [|1. click Sign up for an Individual Account
B . ~ . - f?
RefWorks logu] center under the New to RefWorks? statement.

Weicome to RefWorks
Your Online Personal Database and Bibliography Creator

RefWorks Terms and Conditions

@ 2005 Refworks. All rights ressrved.
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The New User Information screen will appear.

RefWorks

(Al flalds are raquired)

Your Name: .
% | i R .
Login Name .
Password: Gets
& | i
Re-onter Pagsword: 2
E-Mnil Address 3.
5 j
- 4,
Typeofuser. .
* i Select a User Type

Aru of Foous
L3 iSelect a Focus Area

That'
autor

&

Type your full name.

. Type in a login name. The login name can be

anything that you choose.

. Type in your password. The password can be

anything that you choose.
Repeat the password.

Type in your e-mail address. This is important in
case you forget your login or password.

Select Type of User from the dropdown box.
Select Area of Focus from the dropdown box.
Click Register.

You will receive an email confirming your registration and also giving you the GROUP CODE. You
will need the group code if you try to access RefWorks from off-campus.

The Congratulations window will appear. You are now ready to begin importing citations into

RefWorks.
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Once you have a RefWorks account,
DON’T STOP THERE!
BUILD YOUR DATABASE.
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Getting Citations into RefWorks — 4 Ways

There are four ways to get citations (often with abstracts, descriptors and links to full-text) into
RefWorks.

1. Enter References Manually.

2. Direct Exports.

3. Using the RefWorks Search of Online Databases & Library Catalogs.

4. Importing using a RefWorks Filter.

1. Entering References Manually

You may create new references and type or cut and paste the data into the citation.

RGfWOPkS IOghl center - - MR Enter your login name.

Welcome to RefWorks Ik 2. Enter your password.
Your Online Personal Database and Blbliography Creator

3. Click Login.

RafWoks Terms and Condwione

© 2005 Refworks, Al rights reserved.

4. Click on the References menu.
5. Select Add New References.

2] RefWorks

 References {WATCh ~ | View ~| Folders +|Bibllography| Tools ~|Help ~
Add New Reference
 Import

Impaort EndNote V3+ Database
Expont

] Organize Folders Proview Styles ]
1 Backup/Restore

Y aphy How to Enter Citations into your Documant
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Ref W,OI’kS & - 6. Select your potential output style
- (ex, MLA).

| 7. Select a folder for the reference
. (not required).

8. Tell RefWorks what type of
reference you are inputting (ex,
journal).

Search {

-1 9. Complete the remainder of the
form.

10. Click the Save Reference
button.

2. Direct Exports

Many of the LCCC Library Research Databases allow you to directly export citations into RefWorks.

Example 1:

EBSCO

H O S T )Databases

Research EBSCOHost Family of Databases

EBSCOHost Basic Steps:

o~

Conduct a search. :

Click on the Add folder icon to the right of any results you want to save.

Click on the Folder has items link located above the Result List on the right hand side of the screen.
Click on the B Export jink

Select the radio button in front of Direct Export RefWorks, and then click the Save button to initiate a
direct export.
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Results for: ( college students AMD kbrary

FIng: coltege students AND library AND

i’ Academic Sestch Pramier

Retine Search  Rewuits

&

Choase
Ontabanes

Vel
Seatch

Sesrch

Shary in o My (OSCONow Keyword  Publcstions  Sakiesl Yerow - CAsdiciersnces  lngemex

m_amne&mmmumnmm IH!h

mgey

AND research) 2 Agd sexchilatoider K Olsolw ik to seanch

esewch  [Search ) {Clor] @

¥e

To store Hems added to the foldes for afulse

\@m

lh«n
Search

o te My EBSCOhost

These mstructlons assume you have searched an EBSCOHost database and have a list of results.

1. From the result list, click
Add (to folder) for the
records you want to
import into RefWorks.
NOTE: Each folder you
click will change to an

R

Search Search Databases

Kexwerg  Puhlisstions  Subiecilerms  CRed Beferences  lndexes  imeges

Folder Contents
4Back Te store thete hems in the foldes for & rture aesslon, Sign jn to My EBSCOhest. @ Folder has Rems
b Restilt List Homs 2 Resub List homs - \
* lmages © 12662 Page: 1 @& Puny A E-mail & Save 1 Expert
1. Why Johnny Cant Search By: Janes, Joseph. American Libraries, Jan2007, Vol. 38 issue 1, p38-38, 1p; (AN
¥ Persistont Links to 23560115
Searches ® Motea: This title available at LCCC Library
b Saved Searches © B ML Fun Iemmpnp Fult Textciom ﬁnna % Find 1t
R @
2. Undergraduste Stydents’ Book Selection: A Stydy of Factors in the Decision-Making Process By: Stieve,
» Jousnal Alerts @ Thomas; Schoen, David. Joumal of Academic Libratianehip, Nov2008, Vol. 32 Issue B, p599-608, 10p, 3 E
chartg, 2 diagrams, 1 graph; (RN 29563954}
b WebPages® Notes: This title available at LCCC Library
bnnm Elnd 4
Page: 1 i

1301170 Page: 1234 § Hext Sarby: [Cate a Add 11:30) open folder and says
See; Ali Resuine AcademicJonmnals B Magazines @ Hewspapus Added.
Narrow Resulis by Subject 1. Why Johany Canl Search By: Jenes, Joseph. Amencan Libraries, Jan2007, Vol 38 issue 1, 3638, Tp, (AN a 2. Click Folder ha_s items.
COLLEGE siudents 23690115
Neten: This title available 21 LCCC Library " Added
WAIIED Stales 8 HIML Full Tax D ooy Bl i Eld Bt "
VHIVERSTIES & colleces 2, Ire suorecialion is served with @ good doliop of seurce By. Schuchard, Ronald Times Higher Educat a
INFORMATION iteraey Supplement, 12172006 lssus 1771, p17-17, 203p; (AN 23678306) At
LERARIES Fing M Eind bt
INJEBNET in education
m"m‘ . T\omu Schm Dlnd Joumal ofu:uarmc lermnnshwm Vol32lssu05 lDa 3:hans 2 &
ACADEMIC librarians diagrams, | graph; (AN 22593056 added
COLLEGE 1aacheiy Notew: This title wvdiladle ot LCCC Libary
| | Erndwt Eing bty
SC - tecssash | Srom | etnames | iosnss 8| 3 |n the Folder Contents

window, click Export

Export Manager Q@
4 Back

BSCO Research _ ____ . _ ___
- Dkﬂb Sn::llé:h Search‘ Seaich

Advenced

Databases
Sign into My EBSCOhost Keyword Publications  Subject Terms  Citad References  Indexes Images

Hew Search | a&m { Preferences | fle

(S ) e—r

Nuvrn{bow((m to be saved: 2
[¥] Rémove these items from folder after saving

L

Save citations 1o afile formatted for:

& —m———iy ® Direct Export to ReMVorks

O Direct Export to EndNote, ProCite, or Reference Manager
O Genert bib(wm managemsent software

4. The radio button
labeled Direct
Exportto
RefWorks should
be selected.

5. Check Remove
these items from
folder after saving,
if you want to clear
your folder in the
EBSCOHost
Database.

6. Click the Save
button.

Lorain County Community College
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Importing References into RefWorks

The RefWorks User Login page will open (NOTE: You may need to turn off the browser's pop-up
blocker)

;?‘R‘ef W,,dfk’sjl,o'gin:ceﬁtef{f"* © "= Enter your login name.

Welcome to RefWorks R 2. Enter your password.
Your Ontine Personal Database and Bibliography Creator

3. Click Login.

" RafWorks Tarms And Conditions

© 2005 RefWworks, Al rigts reserved.

NOTE: If you are off-campus, you will be asked for a Group Code. ‘This code was sent to you in an
e-mail when you initially created your RefWorks account. Or call the LCCC Library Reference Desk at
440-366-4106 to get the Group Code.
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The RefWorks Import page will open

RefWorks

‘HMerences ~ Search + View » Folders = Biklioqaphy: Teoks ~ Help = Se

Import from ebsco = o

Importing references, please wak...

RefWorks will prompt with /mport
completed when it is finished.

Click View Last Imported Foider to
view your references.

ﬁt { View Lest imported Foder | [ Viewlag |
® RefWorks < e cememctew | 1 RefWorks will display references in

m-m—;so% 3 - Selp » Search fatworks gﬂ
Last Impoi HARE Sotet 0. Sranderd v

Iatuve Focures on Data-Drseen Retenbon Strategrer

.,
E
S
k4

Ercrunr & Reveasion o Bigher Educion, 2005, 17, 12, 1-2. Magra Publicaticns Inc :
Joumal Avferene 2 of 2 : D ot vien it JOLink§
Oolica Surdont Tracking Systeen Hets Reteoticn Award

3

Besmensse & Retegaoa s Hisher Educatiop, 2005, 19, 12, 2-2. Magna Publeatices Inc
ot Refaunca 3 af ¥ Thare imported winw tin J0UAE
Survey Fods Unespected Relationshwp betweea Engageoent and Retension

TeTEY I

Resiukon & Reterion i Hiber Bducanog. 2005, 19, 12, 3-3, Magra Publications Ine

the Last Imported Folder window.

Switch the view by choosing Standard
View, One Line/Cite View or Full
View.

Click the OLinks icon to see if an
article is available in full-text, print or
microform format.

Example 2:

x OSearch OSearch Family of Databases

OSearch Basic Steps:

Conduct a search

Check the Store box for items you wish to export
Click the Stored Records button

Click the Export Records link

Select Direct Export to RefWorks

Click Export Now to initiate a direct export

oohwhN=
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These instructions assume that you have searched an OSearch database and have a list of

results.

ERIC 1966-Present
Ssarch Form Browse +| St Records | M= 3 | s, Hol,ang chat |

Search for. | T i mareds [ Submit Search
{© Seerch Inthesaurus - O Search In current results | AN Search Options - Search History

Limk to; Joumal Aticles - ERIC Documents - Reports-Research * Sincg 1895 | All Limit Options
View: Most frequent subiects - ummmnunumals Most frequent authors

1. esti g Challenge: Buildi iyarsity-Schoplf€irict Parnerships for a
8 eachers ish Le f' alenciana, Christing; Morin, Joy Ann; Morales,
41 pB2:91 Spr 2005
Gt /
2~ QIR QOIS a1l angd the Pla eme Q g gvel vl | eme '-.
Mathemat qurses oAy Urban Comm ege Stydents Maxwell, Wl"im Hagedom,
Linda Serra; Cype| 4«‘ t. Lester, Jaime; Moon, Hye Transler and Retention of Urban Community
-

ICCS 2004

ollege Stuce PP

1. After you submit your search, the
Results List page will display.

2. Check the Store box for citations you
want to export.

3. Click the Stored Records button.

d

ERIC 1966-Presd

| Seaich Form | Browss | [ Sored Recorss| Tis, o, snd hat| (£
e Ay

|snm Records ﬁ- )

Jump o rasults

You have ona stored record. Please chaose one of thes§ ptions:

_Mail Records - For sending records
cﬂy to a spacifiad e-mail address.

« Display Records - For online viewing and

for using your browser's built-in save, print,

or e-mail functions. . Records - For sending records to
» Download Records - For saving records blbloographuc management program like

directly to a fila. Endnote, Procite, Refarence Manager, or
o Puint Records - For automatically printing Refworks.

records. * Pocket Records - For saving records to 4

Palm “Doc" file that can be hot-synced 1o
Pafm Pilot (or ofher Paim-compatible PDA

4. The Stored Records window will
appear.

5. Click the Export Records link.

Lorain County Community College
8/06
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S

ERIC 1966 -Prese
| Search Form| Browse v {Stored Records| _6 |Tips. Help, and Chats| [Exi]| <
Export Options

Risplay - Download - Print - E:Mail - [Expon] - Packet

Exporting one record.

¢ Eaport formats
O Use Refer format (recommended for Endnote)
> Use RIS format (recommended for Refarence M
; and Procite)

{ @ Direct axport to RefWorks

el

| O Download for manual importing

, ] Empty saved record set after

{ viewing

The Export Options window will
appear.

Select Direct export to RefWorks.

Accept the default setting,
Automatically import into
bibliographic manager program.

Click the Export Now button.

Lorain County Community College
8/06
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Importing References into RefWorks

The RefWorks User Login page will open (NOTE: You may need to turn off the browser’s pop-up

blocker)

® RefWorks login center

Homs FA

Welcome to RefWorks [k

Your Online Personal Database and Bibliography Creator

RefWaorks Terrns snd Condisons

© 2005 Retwarks, all nghts reserved.

1. Enter your login name.
2. Enter your password.
3. Click Login.

NOTE: If you are in an off~-campus location, you will be asked for a Group Code. This code was sent
to you in an e-mail when you initially created your RefWorks account. Or call the LCCC Library
Reference Desk at 440-366-4106 to get the Group Code.

The RefWorks Import

page will open

RefWorks
Wfasences = Search * View » Folders ~ Biblography: Took = Help + Se
imporng references, please wat...
Tmport completed - refersaces imported 1
[ view s imported Feider | [ Viewiog |

L

RefWorks will prompt with /mport
completed when it is finished.

Click View Last Imported Folder to

view your references.

Lorain County Community College
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Lavaln County Community Collrge

® RefWorks

e S et hg?-‘C}

J 7t rotder
[l VT :
Tate

hast mparted Yax m b&m

o sl R oo 18
lestigtrve Focimes on Data-Dinven Retertion Strategies

Aathers 3 P
Souwce Resrwmsn, & Retextion jp Hather Educusion, 2005, 15, 12, 1-2, Magon Publscaans foc

Uine o 200 Jouenal Rebwreriee 2 ol 3 Tl imported yian a2 [i0uink

Titke: Crdige Srudent Tricking System New Fetesn Awaed

Authary. 3.

Source.
[+LELTIET
Tle

Jushers:
Scawee

Bacrumment & Reteagon o Higher Bdusaticn, 7003, 15, 12, 2-2 Magna Publcasions Inc

Soumal Raforence 303
Survey Pmds Unexpected Relatonskp berween Engagemen? and Retrrtion.

Chan tmporns viax 1 JR Ok

2003, 19, 12, 3-3, Magna Pubbe ations Inc

RefWorks will display references in
the Last iImported Folder window.

Switch the view by choosing Standard
View, One Line/Cite View or Full
View.

Click the OLinks icon to see if an
article is available in full-text, print or
microform format.

3. Using the RefWorks Search of Online Databases and Library Catalogs

A limited number of databases, mostly PubMed and Library catalogs, can be searched from within
RefWorks and then immediately downloaded into RefWorks. The OhioLINK catalog is included!

RefWorks

All Refe Lookup by Author:
Lookup by Descriptor

Lookup by Perlodical

| Global Edit

RSS Fe

CIRef 101 246 Riference 1 of 75

Title: leraxy Course Pagcs \, 2
Authors:
Source: Libr. Technol Rep., 2005, 41, 3, 33-43, Amer.
[Iref 10: 249 : Journal Raference 2 of 75

1. Go to the Search menu in
RefWorks.

2. Choose Online Catalog or
Database.

Lorain County Community College
8/06
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" 1. Choose an Online Catalog or
Rel V\] (91"];{ S New Refworks |  Database to Search.
Reforonces - Soarch + View * Folders  Eiblography Took ~Help =

Search Online Catalog or Database

2. Enter a Quick Search or an
Advanced Search.

Request a 239.50 Site

R 2 *| 3. Click on the Search button.
Online Catalog or Database to Search:

| OhiaLink
Max, Number of References to Download: ‘L?,Dw‘ﬁ‘

Quick Search for: (Quick Search results are basaed upon the fialds supported by the

|
|

4. Importing Using a RefWorks Filter

Most research databases provide a means to save selected records in a format that can be imported into

RefWorks. Links to online directions prepared by Xavier University for importing from specific
databases can be found at:

http://www xu.edu/library/help/refworks_help.cfm
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Manage Your Citations with Folders

You will likely now want to organize your references into folders. You can organize your files any way
you want — by your class name or by your research topic.

CREATING FOLDERS

1. Within your RefWorks Account, go to

Ref UU OI’kS % L::::,z: the Folders menu.

Referances *|Search ~|View ~/Foldern{Bibllography| Tooks ~|Help ~ o 2530 | 5 Choose Create New Folder.

Last I iCnan New Folder
mported Fold view vla

View "

Y
Giobal Edk

MD:.fAlo, 293 T Book, Whoh R.f:n;.m‘:'l of i
Book Title: 75 E-Learning Activities : Making Online Learning Interactive
Authors:  Watkins Ryan

Source: 2005, 333, Pfedfer, San Francisco

N SN 7 weion 1. Give the folder a name by typing in
Ref U 0 OI’kS Lorain C the New Folder Name box.

Refarences VfSuldl v{\ﬂ-w 'tFoldan VIBIbllogmphy,Tooh '{Holp - Rafsvsg:kd} 2 Click OK

You can create as many folders as you wish.

Now you need to get your references into the folders.

1. Use the View Menu.
2. Select Folders.

3. Select either your Last
Imported folder or your
References Not in a Folder
folder
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i1 ast Imported
References Not In a Folder

huilding

elearning ideas
example

l

Dlnformatlon lite

information litera
Journat | M0 literacy

Clref 101 246
| Title: Library Course Pages .
Authors: tutorials

{ Source: Libr. Technol Rep., 2005, 41, 3, 33-43, American Library Association

Reference Ideas

1©® RefWorks

1.

JL_Addto My Ust |
; Dﬁofibi 2'8'2 ] - 2
f Title: Inihative Z::;r:fg g ideas kn Retention Strategies - 2} )

Authors: information Iict‘eracy

Last Importe )

Source: Reference tdess  her Education, 2005, 19, 12, 1-2, Magna B| 4
i Cref 1 289 tutorials R 20fS .
it Title: Survey Finds Unexpected Relationship between Engagement and Retention

A"l"IMG'

4,

Tell RefWorks which references
to use:

Selected = use the ReflD
checkbox to select.

Page = those references
displayed on the page.

All in List = all references in
the current list.

Choose the folder you want to
move the references into.

When prompted with the Are
you sure ...? Dialog box, click
OK.

You will receive a success
message, just click OK.

Lorain County Community College
8/06
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Create Bibliographies

Quick Bibliographies
RefWorks takes the guesswork out of properly formatting a bibliography.

Welcome, Chiis
Lorain County Co

® RefWorks

References v!Search 'f\llew '(Folden v]Bleo raphyfTooIs viHolp ¥ RefWorks ... ..

List of Output Styles | Request an Qutput Style

Bibliography

;’MLA 6th Edition
{ Edit... ] [New]

Preview Styles

O Format Paper and Blbllography o

w to Enter Citations into your Document

goowmeﬁtto Forrﬁat ! [ Browse... ]

© Format a Bibllography from a List of References , ¥ ,
FleTypetoCreate (WML &g /
Elnduda O Al References (73) O My List (o) © Refarences from | Folder... |

building
e-learning i
example

information
Last Import
Reference |
tutorials

Document Formats Supported

5

« Word for Windows 2000 or later

« \Mimed $ar Mars NO Ar lakar

N

Select Bibliography.

in Output Style, choose
the citation style you
want (e.g., APA, MLA,
etc.).

In File Type to Create,
select what kind of word
processing or other
format you want (HTML,
Word, RTF, Text, etc).

Tell RefWorks which
citations to Include in
the bibliography. Make
sure to choose a folder.
If you don’t select the
citations, the
bibliography will have
EVERYTHING in your
RefWorks account.

Click Create
Bibliography.

Your bibliography will
appear in another window.
You can save it to your
computer using the Save.

Creating in-text references and footnotes. Using Write-N-Cite, you run an abbreviated version of
RefWorks while you work on your paper, allowing you to correctly format in-text references and
footnotes instantly. See the RefWorks Help for additional information about the Write-N-Cite feature.

Using RefWorks with Word

You can use RefWorks in conjunction with Word to automatically insert citations to articles in one of a
wide variety of formats such as the APA, MLA, or Chicago styles, or the style required for a particular

journal.

I. First, you will need to download the Write-N-Cite plug-in on your personal computer.

o From within RefWorks, click on Tools / Write-N-Cite.
o Download either the Windows or Mac version.

Lorain County Community College
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2. Once this is done, you will notice a new option in your Word "Tools" dropdown menu:
RefWorks Write-N-Cite.

3. At the point in your document where you wish to insert a citation, click on Tools / RefWorks

Write-N-Cite.

RefWorks will open; log in.

Choose the folder that you need, or leave it as is to view all your references.

Click on the "Cite" link, in front of the reference you wish to cite.

Click on Bibliography.

Choose the output style: APA, MLA, Turabian, or Chicago styles, or the style required for a

particular journal.

Click on Create Bibliography.

10. Now, go back to your Word document. Depending on the format you chose, you will find a
reference to the citation embedded within the Word document, and the beginning of a list of
references at the end of the document.

XN

o

IMPORTANT!
Review the bibliography to make certain that it conforms completely to the bibliographic style you
chose. The RefWorks system can only work with the data it has been given and there may be some
errors.
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